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Chapter 1

Kerio Connector for BlackBerry

Kerio Connector for BlackBerry is a special module allowing cooperation of Kerio Connect

with BlackBerry Enterprise Server. This module allows users access their data also from their

BlackBerry devices. This data include email folders, calendars, tasks, contacts and notes.

Scheme 1.1 shows process of communication between Kerio Connect, BlackBerry Enterprise

Server, Kerio Connector for BlackBerry module and BlackBerry devices.

Kerio Connector for BlackBerry communicates with Kerio Connect via HTTPS (port 443). Kerio

Connector for BlackBerry forwards messages to BlackBerry Enterprise Server via MAPI. Black-

Berry Enterprise Server then synchronizes messages with BlackBerry device(s).

The same procedure is followed for synchronization in the other direction.

Figure 1.1 Communication between the client and the server

Warning:

During installation, Kerio Connector for BlackBerry connects to Kerio Connect via TCP/UDP

protocol on port 44337.

The following communication during synchronization is similar, but it uses HTTPS on port

443.

Check that the Kerio Connector for BlackBerry host is allowed to access the Kerio Connect

server.
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Chapter 2

System requirements

2.1 Terminology

For easier installation, let us introduce some essential definitions:

• The Windows_Administrator account — the administration account used for login on

the computer where BlackBerry Enterprise Server and Kerio Connector for BlackBerry

are to be installed

Note: As all (including all future) updates of the BlackBerry Enterprise Server and Kerio

Connector for BlackBerry will use this account and password, it is recommended to

use a local account with administration rights that will be excluded from the domain’s

password change policy.

If you change password for this account, communication between BlackBerry Enter-

prise Server, Kerio Connector for BlackBerry and Kerio Connect gets interrupted.

• AD_User account — account of an Active Directory user.

• The BES_Administrator account — administration account for BlackBerry Adminis-

tration Service (This account is created within installation of BlackBerry Enterprise

Server).

• The Connect_Administrator account — administration account for Kerio Connect

Warning:

For better reference and transparency we decided to use descriptive names in the text. For

your purposes, use usernames following your policy.

The only exception is the BES_Administrator account. During installation of BlackBerry

Enterprise Server this account is created with the fixed username admin which cannot be

changed.

2.2 Hardware and Software Requirements

The recommended minimal configuration of the computer for installation of BlackBerry Enter-

prise Server (BES), Kerio Connector for BlackBerry and possibly also Kerio Connect:

• CPU 2 GHz, 2 GB RAM for Kerio Connector for BlackBerry and for the BES server (if

installed on the same computer as Kerio Connect, see the manual).

http://manuals.kerio.com/connect/adminguide/en/sect-systemparam
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Note: Kerio Technologies recommend the following minimal memory configuration:

• 100MB RAM for Kerio Connector for BlackBerry,

• 30MB RAM for every BlackBerry user.

Warning:

Recommended maximum number of active BlackBerry devices is 50.

• Microsoft Windows operating system.

Operating systems supported by Kerio Connector for BlackBerry are listed at the

Kerio Technologies website.

Operating systems supported by Kerio Connect are listed at the Kerio Technologies

website.

List of operating systems recommended by Research In Motion Limited is available at

http://docs.blackberry.com/en/admin/deliverables/18763/.

• Administrator’s account on this computer (the Windows_Administrator account, see

section 2.1).

• Active Directory.

Note: The Active Directory service is required only for BES server installation. No

active users are required to be included.

• The BlackBerry Enterprise Server installation package for Exchange in version 5.0

or later or BlackBerry Enterprise Server Express in version 5.0 or higher and

corresponding license keys.

The BlackBerry Enterprise Server Express installation package and license keys are

available at:

http://na.blackberry.com/eng/services/business/server/express/

• Kerio Connect in version 7.1.0 or later installed.

• Administrator’s access to Kerio Connect (the Connect_Administrator account, see

section 2.1).

• Installation file of the Kerio Connector for BlackBerry module in the same version as

Kerio Connect.

http://www.kerio.com/connect/requirements/
http://www.kerio.com/connect/requirements/
http://docs.blackberry.com/en/admin/deliverables/18763/
http://na.blackberry.com/eng/services/business/server/express/
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Chapter 3

The order of items to install

To get prepared for synchronization of BlackBerry device with Kerio Connect, appropriate

modules must be installed, following this order:

1. Kerio Connect 7.1 or higher

2. Kerio Connector for BlackBerry

Note: Bear in mind that Kerio Connector for BlackBerry must be installed on the same

computer as BlackBerry Enterprise Server. Therefore it is necessary to run Kerio Connector

for BlackBerry installation on a host with such version of Microsoft Windows which is

supported by BlackBerry Enterprise Server (see section 2).

Warning:

If Windows Domain Controller is missing in the network, it is possible to use

the computer on which Kerio Connector for BlackBerry and BlackBerry Enterprise

Server will be installed for this purpose.

3. BlackBerry Enterprise Server

If BlackBerry Enterprise Server has been installed or/and connected to an Exchange server,

it is necessary to uninstall it (including SQL databases).

Although it is possible to install BlackBerry Enterprise Server and Kerio Connect on one

computer, it is recommended to separate these installations to avoid possible technical issues

such as low performance and RAM load.

The following sections describe two scenarios: the recommended installation on two separate

computers and installation of all components on a single computer.

Warning:

However, Kerio Technologies does not provide technical support for BlackBerry Enterprise

Server. Should any issues with BES arise, please contact the technical support of the

manufacturer (Research In Motion Limited).
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3.1 Installation on two separate computers

Figure 3.1 Installation on two separate computers

To make it possible to synchronize BlackBerry device with Kerio Connect, it is recommended

to install components in the following order (supposing that operating systems have already

been installed; for supported versions of operating systems, refer to chapter 2.2):

Computer 1

1. Kerio Connect 7.1 and later (for installation details, see chapter 5).

Computer 2

1. Active Directory (for installation details, see chapter 4).

Note: Install Active Directory only in case that the service is not available yet.

Otherwise, it is possible to add the computer to an existing AD domain.

2. Kerio Connector for BlackBerry of the same version as Kerio Connect (for installation

details, see chapter 6).

3. BlackBerry Enterprise Server (for installation details, see chapter 7).

3.2 Installation on a single computer

To get prepared for synchronization of BlackBerry device with Kerio Connect, it is

recommended to install components in this order:

1. Microsoft Windows operating system (for supported versions, see chapter 2.2).

2. Active Directory (for installation details, see chapter 4).
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Figure 3.2 Installation on a single computer

Note: Install Active Directory only in case that the service is not available yet. Otherwise,

it is possible to add the computer to an existing AD domain.

3. Kerio Connect 7.1 and later (for installation details, see chapter 5).

4. Kerio Connector for BlackBerry of the same version as Kerio Connect (for installation

details, see chapter 6).

5. BlackBerry Enterprise Server (for installation details, see chapter 7).
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Chapter 4

Installing Active Directory

For installation of BlackBerry Enterprise Server it is necessary to have Active Directory service

installed.

If Active Directory is already available, then:

1. Make sure that the computer where Kerio Connector for BlackBerry and BlackBerry Enter-

prise Server will be installed belongs to the AD domain.

2. Then install Kerio Connect (see chapter 5).

If Active Directory is not available yet, use command dcpromo in the Microsoft Windows

command line.

Note: As BlackBerry Enterprise Server needs Active Directory only for installation purposes, it

is possible to install AD temporarily.

Start installation as described below:

1. Login to the operating system with the Windows_Administrator account.

Note: The username Windows_Administrator is only an example (see section 2.1).
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2. Go to the command line and start the wizard by using command dcpromo (see figure 4.1).

Figure 4.1 Starting Active Directory installation
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3. In the Choose a Deployment Configuration dialog, Create a new domain in a new forest,

see figure 4.2) and click on Next.

Figure 4.2 Installing Active Directory
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4. Enter the domain’s name (see figure 4.3) and click on Next.

Figure 4.3 Installing Active Directory
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5. Enter the NetBIOS domain’s name (see figurefig-adinstall4) and click on Next.

Figure 4.4 Installing Active Directory
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6. Select compatibility with previous operating systems (see figure 4.5) and click on Next.

Figure 4.5 Installing Active Directory
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7. In the next step, select the option of installation of DNS server and global catalog and click

on Next.

Figure 4.6 Installing Active Directory
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8. Enter the path for database and logs store of Active Directory and to the SYSVOL directory

(see figure 4.7).

Figure 4.7 Installing Active Directory
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9. Now enter a password for recovery of directory services (see figure 4.8) and click on Next.

Figure 4.8 Installing Active Directory

10. Check installation settings, finish installation and reboot the computer.
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Chapter 5

Installing Kerio Connect

The Kerio Connect installation package can be downloaded at the Kerio Technologies website

at http://www.kerio.com/connect/download/.

Follow standard installation procedure to install Kerio Connect.

For detailed information on installation, refer to the manual.

During installation you create an administration account (e.g. Connect_Administrator) — this

account will be used for installation of the Kerio Connector for BlackBerry module.

Note: The username Connect_Administrator is only an example (see section 2.1).

http://www.kerio.com/connect/download/
http://manuals.kerio.com/connect/adminguide/en/chap-installation
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Chapter 6

Kerio Connector for BlackBerry installation

The Kerio Connector for BlackBerry installation package can be downloaded at the Kerio

Technologies website at http://www.kerio.com/connect/download/.

To install Kerio Connector for BlackBerry, follow these instructions:

1. Login to the operating system with the Windows_Administrator account.

Note: The username Windows_Administrator is only an example (see section 2.1).

2. Run Kerio Connector for BlackBerry installation.

3. Kerio Connector for BlackBerry requires installation of MAPI interface. MAPI

(Messaging Application Programming Interface) is a versatile software interface for email

transmission, developed by Microsoft. If it is not installed on the computer yet, it will be

offered for installation (see figure 6.1).

Install MAPI.

Figure 6.1 Installing MAPI

http://www.kerio.com/connect/download/
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4. Once MAPI is installed, you can install Kerio Connector for BlackBerry.

Installation is a standard process. Confirm licensing policy and module location.

5. Enter password of an administration account on the host (account

Windows_Administrator, see figure 6.2) and confirm.

Note: The username Windows_Administrator is only an example (see section 2.1).

Figure 6.2 Kerio Connector for BlackBerry installation
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6. Enter the server name, username and administration password for Kerio Connect (the

Connect_Administrator account, see figure6.3) and confirm.

Note: The username Connect_Administrator is only an example (see section 2.1).

Figure 6.3 Kerio Connector for BlackBerry installation

Note: The username and password of the Kerio Connect (user Connect_Administrator)

administrator are used for installation only and are not saved within the installation.

7. Finish installation.

Warning:

During installation, Kerio Connector for BlackBerry communicates with Kerio Connect via

TCP/UDP protocol on port 44337.

The following communication during synchronization uses HTTPS on port 443.

Check that the computer where you install Kerio Connector for BlackBerry is allowed to

access the Kerio Connect server.

During installation of Kerio Connector for BlackBerry, a hidden administrator account is

created in Kerio Connect that will use Kerio Connector for BlackBerry for accessing data in

Kerio Connect.

To make the communication secure:

• a strong password is generated for this account,
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Warning:

It is strongly recommended not to change this password.

• Kerio Connect limits IP addresses from which Kerio Connector for BlackBerry will be

allowed to communicate with Kerio Connect.

Warning:

If you change for another network segment, it is necessary to reinstall

Kerio Connector for BlackBerry (see chapter 10.5).
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Chapter 7

BlackBerry Enterprise Server Express installation

The following chapter provides description of installation of BlackBerry Enterprise Server Ex-

press in version 5.0.2.

BlackBerry Enterprise Server Express installation package is available at Research In Motion

Limited product site (http://na.blackberry.com/eng/services/business/server/express/).

Warning:

However, Kerio Technologies does not provide technical support for BlackBerry Enterprise

Server. Should any issues with BES arise, please contact the technical support of the

manufacturer (Research In Motion Limited).

For basic installation of BlackBerry Enterprise Server, follow these instructions:

1. Login to the operating system with the Windows_Administrator account.

Note: The username Windows_Administrator is only an example (see section 2.1).

2. Unpack the BlackBerry Enterprise Server installation package and run the installation.

3. The installation wizard automatically detects domain and username of the administrator’s

account currently used on the system (see figure 7.1).

Figure 7.1 Installing BES server

http://na.blackberry.com/eng/services/business/server/express/
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Continue by clicking on Continue Installation.

4. Confirm the licensing policy and click on Next.

Figure 7.2 Installing BES server
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5. Select the option of creation of a new configuration database (see figure 7.3). Click on Next

to continue.

Figure 7.3 Installing BES server
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6. Select the installation of the full server and select additional components to install (see

figure 7.4), then click on Next.

Figure 7.4 Installing BES server

7. On the next page, check the installation list.

Then confirm settings by clicking on Next.

If you are logged in as a domain administrator (i.e. the Windows_Administrator account is

not a local account with administrator rights), the installation wizard shows a warning

informing that the user account you are currently using belongs to the group of BES

server’s domain administrators (see figure 7.5). Continue by clicking on Yes.
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Figure 7.5 Installing BES server

8. Now install the database server (figure 7.6). Select the appropriate option and click on

Next.

Figure 7.6 Installing BES server
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9. In the next dialog box, enter the password of the Windows_Administrator account, select

the path to the installation folder and to the directory used for storage of logs, specify

name of the BES server (see figure 7.7).

Note: The username Windows_Administrator is only an example (see section 2.1).

Click on Next to continue.

Figure 7.7 Installing BES server
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10. The next page of the installation wizard shows the installation summary (see figure 7.8).

To change any of the settings, browse Back. If all the settings are ok, run the installation

by clicking on Install.

Figure 7.8 Installing BES server

11. If you are asked to reboot the computer, do it and login again with the

Windows_Administrator account.

Note: The username Windows_Administrator is only an example (see section 2.1).
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12. Continue in BlackBerry Enterprise Server installation and enter database information (see

figure 7.9):

• database location (local, remote),

• name of the database server, port settings, paths to data and backup directories,

• authentication type (Windows, SQL).

Confirm creation of the new database and click on Next.

Figure 7.9 Installing BES server
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13. On the next page, enter the license keys (see figure 7.10).

To get license keys, register at the Research In Motion Ltd. website

Figure 7.10 Installing BES server

Verify license keys by clicking on Verify and then use the Next button to move on.
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14. Set BES server administration (see figure 7.11).

Figure 7.11 Installing BES server
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15. Enter username and password of an Active Directory user — account AD_User (see

figure 7.12).

Figure 7.12 Installing BES server
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16. Create an account for BlackBerry Administration Service — account BES_Administrator (see

figure 7.13).

Warning:

For better reference and transparency we decided to use a descriptive name in the

text. During installation of BlackBerry Enterprise Server this account is created

with the fixed username admin which cannot be changed.

Figure 7.13 Installing BES server
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17. In the next step of the wizard, run BlackBerry Enterprise Server services.

Clicking on Next shows addresses of the BlackBerry Administration Service and the Black-

Berry Desktop Manager (see figure 7.14).

To save the addresses for later use you can use option Export the console addresses to a

.txt file.

Figure 7.14 Installing BES server

18. Close the wizard by using the Finish button.

If you selected export of address to a text file, enter the saving path.
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Chapter 8

BlackBerry Enterprise Server (Express)

8.1 Starting to work with BlackBerry Enterprise Server (Express)

The following sections address configuration for BlackBerry Enterprise Server Express 5.0.2.

8.1.1 Accessing the BlackBerry Administration Service

BlackBerry Administration Service is a web interface for administration of the BES server.

The administration can be opened in the following browsers

(according to recommendations of RIM, for more information refer

to http://docs.blackberry.com/en/admin/deliverables/18763/):

• Microsoft Internet Explorer 7 and 8,

• Firefox 3.6,

• Safari 4 for Mac,

• Google Chrome 4.

Note: If you want to connect the device by a USB cable, it is necessary to use Internet Explorer

because it supports ActiveX controls.

BlackBerry Administration Service is available at:

https://the_BES_server_host:port/webconsole/app/

Example: https://bes-server.company.com:3443/webconsole/app/

Primary authentication to BlackBerry Administration Service is with the BES_Administrator

account (see chapter 2.1).

8.1.2 Accessing the BlackBerry Web Desktop Manager

BlackBerry Web Desktop Manager is a web application allowing users to set device

synchronization..

The application can be opened in the following browsers

(according to recommendations of RIM, for more information refer

to http://docs.blackberry.com/en/admin/deliverables/18763/):

• Microsoft Internet Explorer 7 and 8,

• Firefox 3.6,

http://docs.blackberry.com/en/admin/deliverables/18763/
http://docs.blackberry.com/en/admin/deliverables/18763/


8.1 Starting to work with BlackBerry Enterprise Server (Express)

39

• Safari 4 for Mac,

• Google Chrome 4.

Note: If you want to connect the device by a USB cable, it is necessary to use Internet Explorer

because it supports ActiveX controls.

BlackBerry Web Desktop Manager is available at:

https://the_BES_server_host:port/webdesktop/

Example: https://bes-server.company.com:3443/webdesktop/

If users are mapped from the Active Directory, they login to the Web Desktop Manager with

their Active Directory username/password.

In BlackBerry Administration Service it is also possible to go to the user’s settings and define

username and password for access to the Web Desktop Manager.

8.1.3 Creating users on the BES server

1. Connect to the BlackBerry Administration Service (see chapter 8.1.1).

2. Enter the account with the username and password created during the installation (user

BES_Administrator, see section 8.1).

Warning:

For better reference and transparency we decided to use a descriptive name in the

text. During installation of BlackBerry Enterprise Server this account is created

with the fixed username admin which cannot be changed.

Figure 8.1 BES Administration Service — login page
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3. Select Create User . Specify criteria to show Kerio Connect users. Select users to add from

the list and click on Continue.

4. Use option Create user with activation password to create a user with activation password.

Create an activation password.

Note: As the activation password is used only to activate the device (i.e. for pairing of

BlackBerry and the BES server and synchronization settings), it is not necessary to use an

extremely strong password.

5. Complete the process by clicking on Create user .

Kerio Connector for BlackBerry receives a pulse from the BES server and downloads the

following folders of the user account:

• Inbox,

• Sent Items,

• Calendar,

• Contacts,

• Tasks,

• Notes.

Processing of the activation request may take a while.

8.1.4 Activating BlackBerry devices

1. In the BlackBerry device, open Options and go to Advanced Options → Enterprise Activa-

tion.

2. Enter the user’s email address, activation password and name of the BES server. Click on

Activate.

An email message in a special format is sent to the Kerio Connect’s Inbox. Avoid changing

or deleting this message. The BES server reads this message and starts the activation

process.

Note: Make sure that none of the user email sorting filters does not move the message to

another folder.

For detailed instructions, refer to the website of Research In Motion Limited at:

http://uk.blackberry.com/support/enterpriseactivation/

For description on other activation methods, refer to the following link:

http://uk.blackberry.com/support/enterpriseactivation/
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http://docs.blackberry.com/en/admin/deliverables/18778/ (Assigning BlackBerry devices

to users)

8.2 Using BlackBerry Enterprise Server

8.2.1 Checking Server Routing Protocol (SRP) and setting SRP ID

Login to the BlackBerry Administration Service interface (see section 8.1.1).

Go to Servers and Components → BlackBerry Solution Topology → Component View → Black-

Berry Enterprise Server → <instance name>.

Checking SRP protocol settings

1. Click on Edit instance.

2. Go to page Instance Information.

3. Make sure that the displayed value of the SRP protocol status is Connected.

If SRP is not connected, no data can be delivered from/to the device.

SRP ID settings

1. Click on Edit instance.

2. Go to page Instance Information.

3. In section SRP Information, enter the SRP ID and Authentication Key information.

4. Click on Save all and save settings.

8.2.2 Activating S/MIME messages

By default, synchronization of S/MIME messages from and to the device is forbidden on the

BES server.

To change these settings, follow these instructions:

1. Login to BlackBerry Administration Service (see section 8.1.1).

2. Go to Servers and Components → BlackBerry Solution Topology → Component View →

Email → <instance name>.

3. Click on Edit instance.

4. In the Messaging page, under Security settings, set the value of the Turn on S/MIME mes-

sage processing option to True.

5. Click on Save all and save settings.

http://docs.blackberry.com/en/admin/deliverables/18777/Assigning_BB_devices_to_user_accounts_513525_11.jsp
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8.2.3 Selecting email folders for synchronization with a BlackBerry device

By default, synchronization involves folders Inbox and Sent Items.

To add folders to synchronization, follow these instructions:

1. Login to BlackBerry Web Desktop Manager (see section 8.1.2).

2. Go to Email Settings → Redirection Folders.

3. Select folders to add.

4. Click on Save and save the settings.

8.2.4 Selecting contact folders for synchronization with a BlackBerry device

By default, all contact folders are involved in synchronization.

To change the settings, follow these instructions:

1. Login to BlackBerry Web Desktop Manager (see section 8.1.2).

2. Go to Email Settings → Contact Folders.

3. Select folders to add.

4. Click on Save and save the settings.

8.2.5 Synchronizing deleted messages from the device to the server

By default, messages deleted in the BlackBerry device is kept intact on the server. To change

these settings, follow these instructions:

1. On the BlackBerry device, go to the Message application.

2. Go to Menu → Options → Emails Reconciliation.

3. Set the value of Delete on to either Mailbox & Handheld or Prompt.

4. Click on Save and save the settings.
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Chapter 9

Update

The Kerio Connector for BlackBerry version must match the version of Kerio Connect.

Therefore, after update of Kerio Connect it is necessary to update also Kerio Connector for

BlackBerry.

Upgrades of new versions of Kerio Connector for BlackBerry are not performed automatically.

For upgrading, simply run the installation package of the new version.

The Kerio Connector for BlackBerry installation package can be downloaded at the Kerio

Technologies website at http://www.kerio.com/connect/download/.

The installation program will detect the directory where the older version is installed, stop

running components and services, and replace appropriate files with new ones automatically.

All settings and all stored messages will be available in the new version. We recommend not

changing the installation directory!

http://www.kerio.com/connect/download/
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Chapter 10

Troubleshooting

10.1 Logs

Logs can be helpful for troubleshooting purposes.

10.1.1 Kerio Connect logs

When solving issues regarding synchronization of Kerio Connect with the BlackBerry device,

log of the traffic between the server and Kerio Connector for BlackBerry may be helpful. To log

relevant information, enable a corresponding option under Logs → Debug in the Kerio Connect

Administration:

1. In the Kerio Connect Administration, go to the Logs section and select the Debug log.

2. Right-click on the log pane to open a context menu, and select Messages.

3. In the Logged Information dialog just opened, enable particular logs (see figure 10.1).

Figure 10.1 The Debug log settings

4. Confirm changes by OK.

For detailed information on the Debug log and its options, refer to the manual.

http://manuals.kerio.com/connect/adminguide/en/sect-debuglog
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10.1.2 Kerio Connector for BlackBerry logs

The path to Kerio Connector for BlackBerry logs can be found in the Profile Configuration

Utility of Kerio Connector for BlackBerry.

On the Repair tab, click on Advanced. In the dialog box, check options to be included in the

logs (see figure 10.2).

Figure 10.2 Setting logging in Kerio Connector for BlackBerry

The Open file location buttons opens the folder with the Kerio Connector for BlackBerry log

file.

10.1.3 BlackBerry Enterprise Server logs

For details on BlackBerry Enterprise Server logs, see the Research In Motion Limited website

(http://docs.blackberry.com/en/admin/deliverables/18777/).

http://docs.blackberry.com/en/admin/deliverables/18777/
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The key feature for synchronization troubleshooting is the BlackBerry Messaging Agent

component (MAGT ).

10.2 Kerio Connect updates

The Kerio Connector for BlackBerry version must match the version of Kerio Connect.

While updating Kerio Connect, communication between the application and the module gets

interrupted. If synchronization does not work for a certain time period (2 hours), Kerio Con-

nector for BlackBerry sends a message to devices of all users, asking them to contact their

administrator.

Upgrades of new versions of Kerio Connector for BlackBerry are not performed automatically.

Therefore, after an update it is necessary to update also Kerio Connector for BlackBerry.

For update-related information, see section 9.

10.3 Administration account on the computer

It is necessary to install both BlackBerry Enterprise Server and Kerio Connector for Black-

Berry on the computer under the identical administration account Windows_Administrator

(see section 2.1).

Otherwise synchronization of Kerio Connect with BlackBerry fails and it is necessary to

perform a new installation.

10.4 New installation of BlackBerry Enterprise Server Express

BlackBerry Enterprise Server license keys are bound to a specific installation.

If you decide to reinstall BlackBerry Enterprise Server Express, it is recommended to ask Re-

search In Motion Limited to send you new license keys.

10.5 Changing for another network segment

During installation, Kerio Connector for BlackBerry creates a special account which is then

used for communication with Kerio Connect. This account has a strong password and

automatically limits IP addressed from which Kerio Connector for BlackBerry communicates

with Kerio Connect.

If you change for another network segment, it is necessary to reinstall Kerio Connector for

BlackBerry.

1. Stop BlackBerry Enterprise Server.

2. Uninstall Kerio Connector for BlackBerry.

3. Install Kerio Connector for BlackBerry (see chapter 6).

4. Start BlackBerry Enterprise Server.
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Appendix A

Legal Notices

Microsoft, Windows, Windows NT, Windows Vista, Internet Explorer, Active Directory,

Outlook, ActiveSync, Entourage and Windows Mobile are registered trademarks of

Microsoft Corporation.

Apple, iCal, Mac OS, Safari, Tiger, Panther, Open Directory logo, Leopard and Snow

Leopard are registered trademarks or trademarks of Apple, Inc.

Palm, Treo, Pre and VersaMail are registered trademarks or trademarks of Palm, Inc.

Red Hat and Fedora are registered trademarks or trademarks of Red Hat, Inc.

SUSE, openSUSE and the openSUSE logo are registered trademarks or trademarks of Novell,

Inc.

Mozilla and Firefox are registered trademarks of Mozilla Foundation.

Linux is registered trademark of Linus Torvalds.

Kerberos is trademark of Massachusetts Institute of Technology (MIT).

avast! is registered trademark of ALWIL Software.

Symantec is trademark of Symantec Corporation.

eTrust is trademark of Computer Associates International, Inc.

ClamAV is trademark of Tomasz Kojm.

Cybertrust is registered trademark of Cybertrust Holdings, Inc. and/or their filials.

Thawte is registered trademark of VeriSign, Inc.

Entrust is registered trademark of Entrust, Inc.

Sophos is registered trademark of Sophos Plc.

ESET and NOD32 are registered trademarks of ESET, LLC.

AVG is registered trademark of AVG Technologies.

NotifyLink is registered trademark of Notify Technology Corporation.

BlackBerry is registered trademark of Research In Motion Limited (RIM).

RoadSync is trademark of DataViz Inc.

Nokia and Mail for Exchange are registered trademarks of Nokia Corporation.

Symbian is trademark of Symbian Software Limited.

Sony Ericsson is registered trademark of Sony Ericsson Mobile Communications AB.
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SpamAssassin is trademark of Apache Software Foundation.

SpamHAUS is registered trademark of The Spamhaus Project Ltd.

Android and Nexus One are trademarks of Google Inc. This trademark can be used only in

accord with Google Permissions.

DROID is trademark of Lucasfilm Ltd. and affiliated companies.

Motorola is registered trademark of Motorola, Inc.

http://www.google.com/permissions/index.html

	Kerio Connector for BlackBerry
	System requirements
	Terminology
	Hardware and Software Requirements

	The order of items to install
	Installation on two separate computers
	Installation on a single computer

	Installing Active Directory
	Installing Kerio Connect
	Kerio Connector for BlackBerry installation
	BlackBerry Enterprise Server Express installation
	BlackBerry Enterprise Server (Express)
	Starting to work with BlackBerry Enterprise Server (Express)
	Accessing the BlackBerry Administration Service
	Accessing the BlackBerry Web Desktop Manager 
	Creating users on the BES server
	Activating BlackBerry devices

	Using BlackBerry Enterprise Server
	Checking Server Routing Protocol (SRP) and setting SRP ID
	Activating S/MIME messages
	Selecting email folders for synchronization with a BlackBerry device
	Selecting contact folders for synchronization with a BlackBerry device
	Synchronizing deleted messages from the device to the server


	Update
	Troubleshooting
	Logs
	Kerio Connect logs
	Kerio Connector for BlackBerry logs
	BlackBerry Enterprise Server logs

	Kerio Connect updates
	Administration account on the computer
	New installation of BlackBerry Enterprise Server Express
	Changing for another network segment

	Legal Notices

